Recording and Editing Media
with Camtasia Studio for Windows
(Version 8.1)

Learning Technologies Institute
University of Maryland College Park
# Table of Contents

Objectives ................................................................................................................................. 3
What is Camtasia? ......................................................................................................................... 3
Recording a PowerPoint Presentation .......................................................................................... 3
  Accessing the Camtasia PowerPoint Add-in Tool .................................................................... 3
  Steps to Recording a PowerPoint Presentation ...................................................................... 5
  Edit Your Recording .............................................................................................................. 6
Overview of the Camtasia Production Studio ............................................................................ 7
  Timeline Basics ...................................................................................................................... 8
Using the Library .......................................................................................................................... 9
  Adding a Title Clip .................................................................................................................. 9
  Adding Transitions ................................................................................................................ 10
  Adding Audio (Voice Narration) ........................................................................................... 12
Editing Audio and Video ............................................................................................................ 13
  Highlighting Important Parts of the Recording .................................................................... 15
Publishing the Camtasia Recording as a Video File ................................................................. 16
Objectives

In this workshop you will learn to prepare and publish narrated screen recordings. By the end of this workshop you will be able to:

- Capture a PowerPoint presentation and screen actions as a video recording
- Add a title slide and transitions
- Add narration
- Edit the audio recording
- Add custom callouts
- Publish the finished recording as a video file

What is Camtasia?

Camtasia Studio is a computer screen recording tool that allows you to edit and produce video presentations. With Camtasia Studio, you will be able to

- Create video presentations for delivery via the Web.
- Capture your computer screen, PowerPoint presentations and cursor movements.
- Add your screen capture with voiceover narration, call-outs, transitions, zoom-n-pan keyframes, flash quizzes and other special effects.
- Import recordings, videos, images, and audio files into a Camtasia Studio project (.camproj).
- Edit the audio and video tracks.
- Add closed captions to videos.
- Produce the video into a shareable format.
- Share videos on a web site, on CD, or in iTunesU

NOTE: In this workshop we will be using Camtasia 8.1 for Windows; however, there is a Mac version (Camtasia for Mac 2) that is equally as robust except you cannot add quizzes and surveys, produce as a Flash video, batch produce and a few other features that can be found on the Camtasia website.

Recording a PowerPoint Presentation

Using the Camtasia Studio PowerPoint Add-in, you can easily record a PowerPoint presentation. The add-in for PowerPoint records all multimedia elements of your live PowerPoint presentation, including animations and voice narration, and publishes it on a web site or on CD.

Accessing the Camtasia PowerPoint Add-in Tool

There are 3 ways to access the Camtasia PowerPoint Add-in tool.

1. Open Camtasia: From the “Record the screen” drop down menu (see image to the right)
2. Open Camtasia: From the “Tools” menu and then select “Record PowerPoint”
3. Open MSPowerPoint: From the "Add-ins" menu from PowerPoint

NOTE: during the Camtasia Studio installation, the PowerPoint add-in is enabled by default. You can enable the add-in at a later time by selecting Tools > Options > PowerPoint tab > Enable PowerPoint Add-in.

Select the recording options from the PowerPoint Add-in Toolbar

- Begin recording your PowerPoint Presentation.
- Records Audio for the PowerPoint slides.
- Records Camera with the PowerPoint Presentation.

Click the Recording options icon to set up specific options for recording, including (see image below):

- Records the mouse cursor
- Video and Audio Format
- Audio source
- Camera Setup
- Hotkeys for Record/Pause and Stop
Notes about settings:

Program Settings

Start recording paused – if selected, the PowerPoint is displayed in presentation mode with a button to begin recording. This will give you time to get ready and test your microphone one last time.

Record mouse cursor and highlight – this is most effective when describing something on the screen such as a map, a process, etc.

Video and Audio Settings

Record audio – Audio source – make sure that the audio source you are using is selected.

Record audio – Volume – Test your audio by speaking into your preferred microphone. If your audio is being picked up by the program, the green bar will bounce up and down with your voice. If there is no activity, check your audio source and volume.

Picture in Picture

Record from your camera – if you are also recording video, select this option.

Camera setup - Check your camera setup for camera source.

Record hotkey

Take note of these hotkeys. They can be changed. Whenever you wish to stop recording, press "Esc" key.

Steps to Recording a PowerPoint Presentation

1. Click Record to launch the Slideshow.
2. The presentation opens in presentation mode. Check the microphone input level.
3. When ready, select the Click to begin recording button or use the hotkeys.
4. Control the PowerPoint presentation normally during the recording.

![Camtasia Studio Recording Paused](image)

- Microphone

- Click to begin recording

- Ctrl + Shift + F10 to Pause
- Ctrl + Shift + F10 or ESC to Stop

5. Press **Ctrl + Shift + F10 or Esc** to stop recording. Press **Ctrl + Shift + F9** to pause recording.
6. At the end of the recording, choose whether to **Stop Recording** or **Continue Recording**.

![Camtasia Studio PowerPoint Add-In](image)

Your presentation has ended. What would you like to do?

- Stop Recording
- Continue Recording

- Don't ask me again

7. The presentation recording is saved as a Camtasia Studio recording file (.camrec).
8. After you save the file, choose whether to **Produce your recording** or **Edit your recording** before producing it. Choosing **Produce your recording** will take you directly to the Production Wizard within Camtasia Studio while choosing **Edit your recording** will place your recording to Camtasia Studio timeline for editing.

**Edit Your Recording**

Select **Edit your recording** to edit the recording in Camtasia Studio. **Your recording will automatically open in Camtasia Studio.**

If you have added notes to your PowerPoint slides, you can automatically import them to be used as captions. You will also see another window asking you to select your Editing Dimensions. The **Editing Dimensions** dialog box appears the first time you add a clip to the timeline. You can use the default setting for editing or choose the recording dimensions to edit your video.
Overview of the Camtasia Production Studio

The interface for the Camtasia production studio is divided into three main parts:

- the **Clip Bin** tab holds all video, audio, and image clips imported into a project. Think of the clip bin as the homepage for the other **Task Tabs** which provide access to recording, editing, and production options.
- the **Preview Canvas** allows you to view the presentation
- the **Timeline** is used to assemble and edit the video

The **Timeline** represents the sequence of all clips and elements in a video. Once the PowerPoint recording is done, it can be added directly into Camtasia, to be edited. Initially, **video and audio are combined on Tract 1** (see above). The result is that if you edit the audio, it will take out the video also (so if you accidentally cough and remove that sound, the video is also removed and may result in a "skip" in action). The benefit is that the presentation will not get out of sync when removing unwanted audio and video. To separate audio and video, right click on the track and select “Separate Audio and Video”.

---

*(Copyright © Office of Information Technology, University of Maryland)*
Timeline Basics

The timeline is built from a single track or numerous tracks stacked on top of each other. There is only one track by default but others can be added by clicking the “plus” button at the top of the track name list. Tracks can house video, audio or graphics. Graphics and video on the top tracks obscure video and graphics on the bottom tracks. Audio does not work in this fashion; when the playhead is over 2 or more audio tracks, they all play. The timeline is oriented horizontally, so plays from left to right.

Here are some important features:

**Playhead** – The Playhead and “Play” button (Preview Canvas) are synchronized. As the playhead moves around the timeline, the preview canvas shows what it will look like when produced. So if there are stacked graphics, it is best to preview using the playhead to make sure they will render the way you intended. Also, use the playhead to edit audio and video by isolating unwanted sounds and images.

**Time Ticks** – shows the time in seconds and minutes.

**Zoom** – The zoom slider allows you to zoom in for fine-tune editing purposes, like taking out a cough

**Lock a track** – Locking a track means that it will not be edited when editing another track. This is helpful when removing sound from an audio track and you want to preserve the image or the reverse.

**Markers** are automatically generated on the Timeline but can only be viewed by selecting “Show Me Marker View” in the gear drop down list, above the track names. Markers are added for each slide in the PowerPoint presentation and automatically named after the title of each slide. Markers can be used to create a Table of Content for the final video, and also can be very helpful when editing the video.
Using the Library

The Library comes pre-populated with media assets including audio files, call outs, animation, background images, and intro videos for you to use to add professional looking intros, title clips, and more. At the very least, every presentation should have a title slide to introduce the video.

Adding a Title Clip

To ensure a smooth beginning to the video production, you will insert a Title clip. You can create a simple text title clip, or import an image to serve as the background for the Title.

1. Click on the Library tab in the Tasks List window.
2. Select a Theme folder or the Title Clips - Simple folder to view the files. In each of the Theme folders, you will find an animated title slide and a basic title slide (plus an array of callouts and sub-title slides). Editing each of these is slightly different. The Title Clips - Simple are single color slides with a transition on which you can add text. These transitions can be changed or removed.
3. Add a title slide by dragging and dropping it onto the timeline. It is best to put titles on their own timeline track.
4. To add text to a Title Slide, double click the text in the Preview Canvas.
5. This brings up the Callouts tab. Select the font, size and font color. Type the title in the editor.
6. The Preview Canvas will allow you to see how the title slide will look by clicking the play arrow under the preview. Select File > Save.
7. To delete the title slide, select the clip on the timeline and right-click. From the pop-up menu, click “Delete.”
Defining the Duration of a Title Slide

By default, the duration of title slides are 5 seconds long. You can change the duration in two ways:

- Dragging the sides of the clip. This is quick but is not very precise.
- Right click on the clip itself to bring up the menu. Select Duration and enter the seconds. Click OK to save. This is very precise but only works on the text portion of animated title slides.

Adding Transitions

The Title Clip and recording now represent two segments of the production. To create a smooth interchange between the two parts you can insert a transition effect. Transitions add a visual effect between the end of a clip and the beginning of the next clip and at the beginning and end of a presentation. Camtasia provides a variety of transition effects that can be previewed simply by double-clicking on any one effect thumbnail in the Transitions window.

Steps to adding a transition to your presentation:

1. Select the “More” tab from the effects menu
2. Select “Transitions” from the dropdown menu
3. Preview some transitions until you find one that you like
4. Drag the selected transition down onto the timeline. All of the areas where you can add a transition will be highlighted yellow. This is between two video clips or at the beginning and end of the videopresentation.

5. Once the transition is placed, it will appear like a green bar between the two slides.

![Transition](image)

6. To increase or decrease the duration of a transition, click on it and slide with the cursor.

7. To preview, move the playhead before the transition and click the “Play” arrow in the Preview Canvas.

8. To remove a transition, select it and click “delete” on your keyboard.

---

**Special Note about Adding Transitions to Powerpoint Presentations**

When you record a Powerpoint presentation, it is one continuous video recording. This means that if you would like to add transitions between your Powerpoint slides in Camtasia, you must first break each slide into a separate clip. This is much easier than it may seem.

1. Select the “.camrec” file by clicking on it. It will turn blue when selected.
2. Choose “Show Marker View” (see Timeline Basics above). A marker is placed at the start of a new slide. Each marker is a blue diamond with a blue vertical line running through it.
3. From the “Edit” menu at top, select “Markers”
4. Select “Split at all markers”

![Marker View](image)

5. Now, you can add transitions between all of the Powerpoint slides using the method outlined previously.
Adding Audio (Voice Narration)

Use voice narration to insert a voice recording into the video. It is possible to narrate your screen recording while you are creating it, but many people find it difficult to juggle performing the recorded tasks and talking through the process at the same time. In this case, it is possible to add the Voice Narration after you have created the Camtasia project file to complete the production. It is strongly suggested that you rehearse this a few times before actually recording the Voice Narration. When you click on the Voice Narration link in the Task List (if you do not see it, select the "More" tab), you will see these recording options.

![Voice Narration UI]

Start recording button
When you are ready to record your audio, position the playhead where you would like the narration to begin. Press the “Start recording” button. To stop recording, press this button again.

Mute speakers
It is usually suggested that you use a headset device to record your vocal narration; this option keeps the speakers built into your computer from echoing back or enhancing the volume of your narration.

Input level
Position the Input level slider between 60 and 70%; it is possible to modify the recorded sound after you have finished. If there is no green bar bouncing as you speak, then it may not be picking up your speech. If this happens, go to the “Audio Setup Wizard” button.

Audio setup wizard
Confirms the source of your audio (microphone, etc), volume, and other advanced features.

NOTE: For best sound quality, it is recommended to use a microphone before recording narration.
Steps to recording narration for a presentation:

1. Position the playhead to a frame on the Timeline or drag the playhead to select a section on the timeline.
2. In the Task List, select Voice Narration (if it does not show as a tab, click “More”). The Voice Narration pane appears.
3. Enable the “Mute speakers during recording”. The microphone may record audio playing from the computer.
4. Check that your audio source is being picked up before recording by checking the input level. The green bar should bounce up and down with your speech.
5. Click Start Recording.
6. When you are finished, click the Stop Recording button.
7. Name and save the audio clip.
8. It will be placed automatically on the timeline on a track of its own. A copy is also placed in the Clip Bin.

Editing the Audio and Video

When the recordings are complete and added to the timeline, the next step is to edit out the irregularities. Here are a few pointers:

- When removing a piece of unwanted audio or video, remember to lock tracks that you do not want affected. (Example: lock a video track when editing an audio track)

- Use the “wings” on the playhead to isolate the area to be deleted. To double check your selection, click on the play button in the Preview Canvas.

- Use the zoom button, on top of the tracks, to further isolate an unwanted sound, etc. The goal is to remove the least amount of recording to prevent “skipping” of sound or video.
**Editing tools**

Across the top of the timeline are the following editing tools:

- **Undo** – undo an edit
- **Redo** – redo an edit
- **Cut** – remove an area of the timeline
- **Split** – split a recording into two or more pieces. Good for adding transitions and other recordings.
- **Copy** – copy a selected area on the timeline
- **Paste** – paste copied recording on the timeline

**Audio Editing**

Once you have finished your narration you will see one or more audio tracks associated with the clips in your presentation. To edit the audio, you need to first select the area you want to edit on the Timeline Use the **general editing** tools (above) to remove sounds such as coughs and umms. Use the **Audio editing tools** (task tab) to increase or decrease the soundtrack, fade audio out or in, remove extra sounds and add silence.

**Steps to Removing Audio Bytes**

1. **Use the zoom tool to isolate the sound**, and the **playhead to mark its place** on the timeline.
2. Click the “Play” button on the Preview Canvas window to verify the sound to be removed
3. **Lock all tracks not to be edited**. To keep the video in sync with the audio, it may be best to remove both audio and video. If this will create a “jump” in the action, then lock the video track.
4. **Click the cut button (scissors)**
5. Save presentation

**End of Presentation Effects**

It can be a nice effect to add a very short (15 sec) piece of music at the end of your presentations as well as an ending title slide (“The End”). This alerts the viewers that the presentation is over and gives it a professional effect look. Here are the steps to add the music fade effect:

1. Find a short music clip in one of the **Music folders** in the **Library** and drag it on your timeline
2. Using the playhead, move your cursor to the end of the last slide. Have the last slide clip show for about 15 seconds. **Right click on the clip to adjust the duration.**
3. **Lock all tracks** except the one that the music clip is on
4. **Click on the music track.** It will highlight.
5. **Click on the “Split” general editing tool.** Delete everything to the right of the split (end of visual presentation).
6. Again, using the playhead, **highlight the music clip** that is left.
7. **Select the Audio tab** from the Task Manager
8. **Click the “Fade Out” button** so the song will gradually fade at the end of the presentation. Soften the song even more by selecting the “Volume Down” button until you are satisfied.

![Editing Tools](image)

**Highlighting Important Parts of the Recording**

Callouts enable you to add graphic annotations, like highlighting colors, boxes, arrows, etc. to your video. It is best to add these last, as with editing they may shift.

1. Move the Playhead in the Timeline until you see the frame that you wish to annotate with a graphic in the Preview window.
2. **Click on the Callouts tab.**
3. Scroll through the shapes options. Some shapes have a drawing action to them and are called “Sketch”.
4. Choose the Arrow callout option by clicking the **“Add Callout” button.**
5. **Resize the arrow and refine its position** in the Preview window.
6. **Click an insertion point** in the Callout text box and type a label for the arrow: **Start Here.** Note that you can format this text in terms of font, font size and alignment.
7. **Additional Callout properties** include Fadein, Fadeout, Drop shadow (to augment the arrow). The Fadein and Fadeout properties insure that the callout item doesn’t just pop into the recording; they enable the Callout object to appear and disappear from the recording slowly (usually about one second in each direction).
8. **To remove the callout,** select it in the Preview Canvas and select the **“Remove Callout” button.**
Publishing the Camtasia Recording as a Video File

Camtasia provides a Production Wizard that will step you through the decisions needed to save and publish the recording. It contains production settings optimized for your intended distribution method: Web, CD, DVD-Ready, iPhone, iPod, Web, or YouTube.

1. From the top of the Camtasia canvas or the File menu, select “Produce and Share”
2. The Production Wizard appears. The preset selected in the Project Settings dialog is automatically selected. Camtasia will produce your video as MPEG-4 (MP4) format with player file. The “player” is desirable so that students can pause and start the program as they choose. There is a pull-down menu for other video format options.
3. Click Next.
4. Enter a name and file location and click Next. Click Finish.

General Rule-of-Thumb on File Types and Screen Resolution Choices

1. **Web Distribution:**

   The Flash output (MPEG-4, FLV or SWF) creates a high quality, low file size video for playback on multiple Web browsers.
   - The MPEG-4 file format offers the best compression for both screen recordings and high motion videos. MPEG-4 video has small file size, and great video quality.
   - The SWF file format is good for producing short videos (approximately 15 minutes or less) that do not contain a great deal of motion, such as transitions, Zoom-n-Pan keyframes, or animations.
   - FLV is good for long or full-motion screen videos.

2. **Recommended screen size of finished production**

   No Larger than 800X600

   Once the compression of the production begins, you will see a status bar showing the progress. The larger the file, the longer the wait.

Once your video is produced, several files associated with the video are created as part of the production package. All files would need to be uploaded to a web hosting server in order to make the video available via a web browser. The html document will be the launching point for the video.